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INTRODUCTION
Welcome to OU Campus, the content management system (CMS) for Hope College.
The OU Campus interface provides us with an intuitive way to manage web pages and
repurpose content. It includes custom workflows and has been set up with an approval
process that allows you to send completed pages to a designated approver, usually
someone in Public Affairs and Marketing.
Pages are checked out to only one user at a time to prevent users from overwriting each
other’s work. The system changes who the page is checked out to as the pages move
through the workflow system.
As someone who maintains content for the Hope website, you have been given access to
specific content that you have permissions to edit. When you create new pages,
preconfigured templates provide consistency to the overall web site design.
This users’ guide provides detailed instruction on how to use the CMS to manage your
website content. It is intended to be the go-to guide for anyone at Hope who maintains
web content.
If you have any questions that aren’t answered here or need assistance, please contact
Public Affairs and Marketing.

Josh Bishop

Jason Cash

Craig Tommola

Web Content Manager
bishopj@hope.edu
x7066

Director of Web Communications
cash@hope.edu
x7085

Web Developer & Designer
tommola@hope.edu
x7048
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LOGGING IN
To log in to OU Campus, use your 1Hope login and password at the OU Campus login
screen.
You can get there one of two ways:
1. OU Campus login for hope.edu:
http://hope.edu/ou

TIP: Navigate to your office or department’s website folder in OU Campus, then bookmark
that page. That way, you won’t have to navigate to the folder every time you log in.
2. DirectEdit™
Go to the hope.edu page you want to edit, then scroll down and click in the hidden button
at the very bottom of the footer.
You can use direct login from any hope.edu page, not just the one you want to edit.
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INTERFACE
Global Navigation Bar
The global navigation bar is the primary way that you will navigate through OU Campus.

•

Dashboard: Includes access to your workflow, inbox and Dashboard gadgets. The
Dashboard is the default location when you are not logging in via a DirectEdit link on
a page.

•

Content: The Content menu includes access to the main area for editing pages and
assets.

•

Reports: Provides access to administrative-level reporting and content management
functionality.

•

Add-Ons: Provides access to additional applications for access through the OU
Campus interface (Access to add-ons may be limited by a user’s permissions.)

•

User Avatar or Gravatar, and User Name: The menu provides access to the
your settings.

•

Help: Help menu items include access to the Support Site, OCN, New Features and
Feedback Forum, and release notes.

Dashboard
The Dashboard includes access to your workflow and inbox, and the configurable content
area can contain various Dashboard gadgets:
• My Checked-Out Content (pages checked out to you)
• Activity (an activity feed for the site)
• Inbox
• Site Analytics
• Workflow
For more information, see Dashboard on page 6.

Content
The Content menu is the gateway to the most frequently used section of OU Campus, as it
includes the capability to create and edit content. It consists of:
• Pages
• Assets
• Recycle Bin
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You can navigate the Pages list view in order to edit, create and publish new content. This
might also include reviewing changed pages and submitting pages for approval.

Reports
The Reports menu includes reports about content and content status, such as the number
of checked out pages currently in the site. Reporting capabilities include information on
required actions, checked-out content, pending approvals, scheduled actions, recent saves
and recent publishes.

Add-Ons
The Add-Ons menu allows custom or third-party applications to be accessed within the
OU Campus interface. The availability of add-ons may be limited.

User Avatar or Gravatar, and User Name
The top right of every screen shows your name and avatar. Hover over your name to
access the menu to change your personal settings or log out.
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Help
The Help menu includes several links to additional support resources for users, including
links to the Support site, OmniUpdate Community Network (OCN), New Features and
Feedback Forum, and version release notes.

Dashboard
The OU Campus Dashboard provides a location within the CMS where each individual
user can access user-specific messaging and gadgets. The Dashboard is the default login
location from the standard OU Campus Login screen when not utilizing DirectEdit.

6

In the Dashboard menu on the global navigation bar, you can find links to Workflow and
Inbox. These options are also found beneath your user name on the Dashboard overview
page.

There are three options on the Dashboard menu in the global navigation bar: Overview,
Workflow and Inbox.

Overview
Clicking Overview will take you to the Dashboard overview page (seen above). Simply
clicking the Dashboard link in the global navigation bar will take you to the same location.

Workflow
The Workflow list view shows content that you’ve sent to another user for approval or, in
some cases, content that has been sent to you for approval. These messages are separate
from other messages (which can be viewed in Inbox and Sent). Content moving through
an approval process can be tracked using this screen.
For more information on Workflow, see page 105.

Inbox
Inbox displays messages from other users as well as automated messages associated with
scheduled actions, such as a notification that a page has been published or notification of
page expiration. The Inbox Gadget is also shown on the Dashboard and includes the
number of new messages in the inbox. The Inbox includes a linked list of messages and the
functionality to compose a message.

Dashboard gadgets
A gadget is a little program that provides additional functionality or streamlined access to
functionality within OU Campus.
Frequently displayed gadgets include Inbox for messaging, site analytics, and the My
Checked-Out Content Gadget, which lists all content that is currently checked out by the
user.
•

Activity: Activity shows content with recently performed actions such as a scheduled
publish, expire, or upload.

•

My Checked-Out Content: Shows the content checked out by the current user and
the date/time stamp that the content, which can be a page, asset, or file, was checked
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out. Within this gadget, the pages are linked and can be clicked to for editing or
approving. The light bulb icon indicates the page is checked out and clicking the icon
checks the page back in.
•

Inbox: Provides a scrollable list of recently received messages.

•

Site Analytics: Provides analytics through Google Analytics directly inside OU
Campus.

•

Workflow: Gives users the ability to track all workflow items they are involved in
from one gadget. Users involved in a particular workflow item can message each other
directly inside the gadget.

Customizing your dashboard
You can customize your Dashboard by choosing which gadgets to show or hide.
1. Click the Configure Dashboard button in the upper left.

2. Select the gadgets you want on the Dashboard from the options available in the popup
window.

Gadgets can also be reordered on the Dashboard by clicking and dragging the grey title
bar to a new “tile,” shown by a dotted line.
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Pages List View
The Pages list view provides access that allows you to create new content, upload files and
edit new content. It provides a view of the pages, files and directories that make up the site,
as well as the additional functionality available for each file and directory. Navigate to this
area from the Content button in the global navigation bar or Content > Pages.
Hover over the row corresponding to the content for more options.

The Pages view includes the following features and functionality:

Breadcrumb
Click a link to navigate to any directory (folder) in the breadcrumb. It includes the
clickable Home icon to quickly navigate to the site root. Clicking a linked directory
displays its files and subdirectories

New
The New button provides access to templates for creating new content.
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Upload
The Upload feature provides the ability to upload files. The ability to upload a file is
available in the Pages list view, as well as in conjunction with other features such as the
Insert/Edit Image tool in the WYSIWYG Editor.

Filter/Quick Search/Advanced Search
Simply type into the field to filter the current list view. Pressing Enter will initiate the
Quick Search feature, which searches within the specific content of pages or within meta
tags in order to easily navigate to pages. Clicking Advanced Search will bring up the
Advanced Search modal for more specific searches.

Content List
The list can be sorted by file type, file name, date/time it was last modified and status.
Hovering over a row will reveal additional options under the Options heading.

The list view includes the following columns:
•

Checkbox: For selecting multiple files and/or directories on which to perform an
action. Selecting the checkbox in the column header selects all files listed, including the
files within a directory. Multiple content items may also be selected individually. For
files checked out to the current user, Publish, Copy and/or Move to Recycle Bin are
available. When files checked out to others are selected, only Copy is available.

•

File Icon: The file icon provides a visual indication of the file type (e.g., media file
type, image file type, PDF, Word document, etc.)

10

•

Name: Shows the file name and extension, which can be clicked to enter Preview
mode. The functionality present in Preview is dependent upon the file type. The
Name column also shows the file size in bytes or kilobytes.

•

Status: Shows the icon indicating page status.

•

Modified: Shows the date and time of the last save.

•

Options: Additional actions and operations are available under the Options column
when the file is selected via checkbox or hovered over. See below for more
information.

File and Directory Options
This section provides an overview of the menus and functionality that can be accessed
under the Options heading from both the staging and production servers in the Pages
list view. The available menus and actions for each row vary depending on user level,
access settings, file type, and file status. On staging the four options include:
• Edit
• Review
• Publish
• File
On the production server or publish target, the following are available:
• View
• Rename
• Move
• Delete

Edit Menu
Allows you to navigate to the Edit view or Source Editor for the page and edit reminders.

Review Menu
Allows you to preview the page, save a version of the page and view the Versions and Log
for the page.

Publish Menu
Allows you to submit files or directories for approval. Users with permissions can Publish,
Schedule Publish and Expire. This menu will only be available if the file is checked out to
the user.

File Menu
Allows users to perform various file actions, such as copying, moving, renaming, or moving
a file to the Recycle Bin.
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Checked Out/In
Checking out a page or file in OU Campus effectively locks it so that other users cannot
check it out and prevents two editors from overwriting each others' changes. When you
edit a page by clicking on an editable region button, or click to the page a from a list view,
the page is automatically checked out to you. Likewise, when you submit a page to an
approver, it automatically checked out to that approver.
No other users can enter a checked-out page and make changes until the file has been
checked back in. (Administrators can manually override this feature.)
OU Campus also has status indicators help make clear why a page is not available for
editing as well as who has checked out a page or scheduled an action, or whether the page
is in the process of a workflow. These icons are shown on many of the screens that display
content lists.
File status indicators reflect the state of an OU Campus page and other files, including
whether it is checked out. A lit light bulb indicates a page is checked out to the currently
logged in user and a red lock indicated the page is checked out to another user. An unlit
light bulb indicates the file is checked in and available to be checked out.

Page Status Indicators in File Navigation Sidebar

Checked-Out Pages in Gadgets Sidebar
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Status Indicators
Icon

Description
An unlit light bulb indicates that the page is checked in and can be checked
out for editing by any user with the proper permissions.
A lit light bulb indicates that the page is checked out to the current user (the
individual currently logged into OU Campus).
A red lock indicates that the page is checked out to another user. Users can
hover over the lock to see who has checked out the page.
A green calendar icon is the status indicator for a publish scheduled by the
current user. Administrators or the individual who scheduled the page to be
published can click on the icon to change the publish date and time or cancel
the publish completely.
A red calendar icon is the status indicator for a publish scheduled by another
user. Administrators or the individual who scheduled the page to be published
can click on the icon to change the publish date and time or cancel the publish
completely.
A red circle with a line through it is the status indicator for an expire
scheduled by the current user or another user. A scheduled expire can be
removed or rescheduled by the user who scheduled the expire. An
administrator can check in the page, which effectively cancels the scheduled
expiration. This icon is displayed to all users, not just the user who scheduled
the expiration.

Checking In a Page
It is valuable to note that pages stay checked out to the user until the user:
• Sends the page to another user for review.
• Publishes the page.
• Checks the page back into the system by clicking on the lit (yellow) light bulb.

Behaviors of Checked Out Pages
If a page is checked out by another user, the current user may still perform the following
actions; even though the page is locked:
• Edit access settings
• Edit reminders
• Preview the page
• View the log
• Copy the file
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Available Actions for a Locked Page

Best Practices
•

Make sure to check the page back in when finished editing the page so it can be made
available to other users.

•

OU Campus supports WebDAV and can be enabled by a Level 10 administrator.
When WebDAV is enabled, OU Campus supports file locking with specific WebDAV
clients that utilize file locking.

Gadget Sidebar
A gadget is a little program that provides additional
functionality or streamlined access to functionality
within OU Campus. Gadgets are available
throughout the site. In any event, gadget access
may be limited by access and permissions. Some
gadgets are only located on the Dashboard or on
the Gadgets sidebar, while others are available in
both locations.
For information about Dashboard gadgets, see the
Dashboard section on page 7.
The Gadgets sidebar is a global element that can
be shown or hidden by the user. The sidebar
exemplifies responsive design as the sidebar also
automatically collapses or expands when a browser
is resized. The Gadgets sidebar can be shown by
clicking on the Show Gadgets button at the top
right of the screen.
Once the Gadgets sidebar has been expanded,
individual gadgets can be collapsed or expanded
and the user can configure which gadgets appear in
the sidebar. The gadgets that are available on the
sidebar are dependent upon the implementation of
the site and can be configured by a Level 10 administrator.
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Gadget Sidebar Icon Reference
Icon

Name
Show Gadgets

Description
Click the plug icon to show the Gadgets sidebar.

Choose Gadgets

Click to display the Choose Sidebar Gadgets modal from where
it can be determined which gadgets to show on the sidebar.

Hide Gadgets

Click the arrow to hide the sidebar.

Expand Gadget

Click to expand the gadget on the sidebar.

Collapse Gadget

Click to collapse the gadget on the sidebar.

System Gadgets
The Gadgets sidebar may include the following system gadgets:
•

Dependency Tag Info: Search functionality for dependency manager tag that
reports information about the tag.

•

My Checked-Out Content: Shows the content (a page, asset or file) checked out by
the current user and the date/time stamp that the content was checked out. Within
this gadget, the pages are linked and can be clicked to for editing or approving. The
light bulb icon indicates the page is checked out and clicking the icon checks the page
back in.

•

Images: Drag and drop images from any folder into edit views.

•

Page Info: Displays information about the file currently being viewed or edited.

•

Page Analytics: Allows users to view Google Analytics data for the page they are
currently viewing or editing.

•

Snippets: Drag and drop any snippet into an edit view.

•

URL Shortener: Provides a utility to shorten a URL, which can then be dragged
onto a page.

•

Link Check: Check for all broken links on a page in OU Campus and send a report
to any user.

•

Page Parameters: Edit page parameters directly from the gadget without having to
navigate away from the Preview or Edit view.

•

Request Help: Sends page and user information along with a custom message to a
pre-defined group in OU Campus who can help users in need.
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•

Workflow: Same functionality as the Workflow dashboard gadget.

•

YouTube: Drag and drop YouTube videos from linked YouTube channels or by
searching all of YouTube.

Choosing Gadgets on the Gadget Sidebar
To show and hide gadgets in the Gadgets sidebar, click the Choose Gadgets icon (circled)
to be taken to the Manage Sidebar modal.
The Manage Sidebar modal shows available
Sidebar gadgets. Gadgets that are currently
available on the Sidebar are listed and can be
filtered by name. Functionality includes:
•

Filter: Enter two or more characters to filter
by gadget name.

•

Hide: To hide a gadget from view on the
Sidebar, click anywhere within the green
gadget box or click the checkbox to clear the
selection. A hidden gadget is shown in gray.

•

Show: Click anywhere within the gadget box or the checkbox to select a gadget to
show on the Sidebar. A shown gadget is displayed in green.

Rearranging Sidebar Gadgets
You may relocate the gadgets on the sidebar by dragging them into a different order. Click
and hold on the gadget's title bar and move the gadget up or down in the list.
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CREATING NEW PAGES
A new page can be created from existing templates within the OU Campus system by
accessing the Pages list view. The Pages list view can be accessed by selecting Content >
Pages from the global navigation bar.

NOTE: Not all users have access to create new pages, and users with access to create new
pages may have restricted access to the type of template they can use.

To create a new page:
1. Navigate to the Pages list view by selecting Content > Pages from the global navigation
bar.

2. Click the
dropdown menu, then select the
type of page you’d like to create from the available
templates.

NOTE: If you click the New button instead of
the dropdown indicator, you will be taken to a
new window that displays available template
options.
The most common templates that will be used in your
website are Landing Section, Landing Page, Standard
Section and Standard Page.
A page template is a single page. A section template
has subpages and its own navigation menu. For
example, your office or department homepage was
probably built with a section template, while its faculty
and staff listing was likely built with a page template.
A key difference between Landing and Standard
templates is that Landing templates have a banner
image or slider at the top of a page while Standard
templates do not.
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Landing page

Standard page

18

3. After you select your template, the New Page window will appear. This window contains
the fields necessary for page creation, including filename, basic metadata, page parameters
and custom template options.

4. Fill out the New Page information. You usually won’t be adding content at this stage.
(That comes later.)

New Page Information
General Page Setup
•

Page Title: The name of the page. For your home page (index), this will be the name
of your office or department, followed by a vertical pipe (one of these things: | ) and
then “Hope College.” For example:
Department of History | Hope College

For other pages within your section, use the name of the page, followed by a bar and
the name of your office or department. For example:
Staff and Faculty | Department of History

•

Description: This meta data for your page will display with search results on a
search engine, and helps users find your page — and determine if your page is what
they’re looking for. Summarize your page content using active language. Try to
include the keywords that a user might type into a search bar. If you can, keep it
between 150 and 160 characters. Keep it alphanumeric, and no quotation marks; if
you must use quotation marks, use single quotes.
Undergraduate research is a critical element of a Hope College
education, with opportunities available to students and faculty
in every academic discipline.
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File Configuration
•

Add Navigation Item: Except in very rare cases, keep this set to Yes. Doing so will
automatically add your page to the left-hand navigation menu.

•

Layout (Landing Page template only): Select the layout you’d like to use for your
page. We recommend leaving this on the default setting; custom page properties can
be modified later as needed.

•

Filename: The name of your file within OU campus and also part of the URL
structure. Pretty much the name of your page with a few changes:
• Use only lowercase letters
• Use dashes instead of spaces
• Remove words like “a,” “and” or “the”
E.g., staff-faculty, young-alumni-award, arts-humanities

New Section Information
Use the guidelines for New Page Information (above), with the addition of the following
fields:
Folder Information
•

Directory Name: The name of your folder within OU Campus. This is also part of
the URL structure, and should follow the same guidelines as Filename:
• Use only lowercase letters
• Use dashes instead of spaces
• Remove words like “a,” “and” or “the”
E.g., public-affairs-marketing, student-development

•

Folder Breadcrumb: A breadcrumb is a trail that allows users to see where they are
within the site and navigate to other pages. This should be a simple version of your
page name (not including the | and subsequent information). Use capital letters as
appropriate and do not use hyphens.

5. When the information is complete, click Create.
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To create a new factoid
Factoids are the files that populate the By the Numbers sections of a webpage.

1. In the Pages view, navigate to _resources > factoids then select the folder where
your section of the website best fits (e.g., if you’re in an academic department, build the
factoids in the academics folder).

2. Find or create a new folder for your department or office.
3. In your folder, click the drop-down and select Factoid or click the New button and select
Factoid from the New Content window.
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4. Fill in the fields in the New Factoid window.

•

Title: This should be the shortest, simplest
possible explanation of the data. For example,
instead of saying “The number of puppies
playing in the Pine Grove,” simply say
“Puppies.”
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•

Number: Enter the number. If the number is
especially long, you may want to abbreviate it
(e.g., 6M instead of 6,000,000)

•

Description: Describe the number. This is
the paragraph that appears on mouse-over.

•

Link (optional): Provide the URL or, for internal pages, the dependency tag for a
destination where users go upon clicking.

•

Link Text (optional): The text that will appear
in the link button.
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•

Color: Select the background color for your factoid. Note that this should match the
color of the background you select in the next field (Background).

•

Background: Select the file you want to use as the background. Do not select large
(lg) or medium (md) files. Note that the color should match your background color.

•

Filename: Enter a filename using only lowercase letters, underscores or dashes (e.g.,
daa-creative-writing).

5. Click the Create button.
6. Preview the factoid, then Publish or Submit for Approval.
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PAGE ACTION TOOLBAR

When you’re viewing a page in OU Campus, several utilities are available at the top of the
screen in the form of the Page Actions toolbar. (These actions differ depending on page
status, access settings, and other variables.)
The Page Actions toolbar includes the following:
•

Preview: Displays the page in preview mode.

•

Edit: Displays the page in edit mode, which includes editable regions. If you check out
the page, you’ll have access to additional utilities. (Clicking an editable region will
automatically check out the page.)

•

Properties: The Properties page gives you access to edit various other page items,
allowing you to change page headings and breadcrumbs, enable or disable such
features as calls to action, events and news, and add blog posts to your page (among
other things). This is available when the page is checked out. A page or file must be
checked out to view or update parameters.

•

Versions: Allows you to view previously published or saved versions of the page
when you have the page checked out.

•

Page Check: Displays the Page Check options when you have the page checked out.
This will allow you to run any available page checks (e.g., Spelling, Links).

•

Save Version: Use this to save a version of the current page. This option can be
especially useful when you’re making significant changes and don’t want to lose your
existing content. This is available when you have the page checked out.

•

Check Out/In/Lock: This is the little light bulb icon. It allows you to check out a
page that is not already checked out by another user. When you have the page
checked out, the light bulb turns yellow; to check the page back in, simply click the
light bulb again. If the page is checked out to another user, a lock icon is shown.

•

Submit /Publish: After choosing an editable region and editing the page, the
Submit for Approval button is available. (Some users will have a Publish button.)
Clicking the button will bring up the Publish modal. The available actions in this
drop-down menu include Schedule, Submit for Approval and Expire.

•

Server Drop-Down: The Server drop-down menu gives the user the option to view
the site from the staging server or as it currently looks on the published production
server. This menu is only available from the Preview view for users with permissions.
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•

Output Selector: If the site’s templates have been configured to provide more than
one output type (for example, HTML, PDF, or XML), the output to view can be
selected from the drop-down menu. This menu is only available from the Preview view
for users with permissions.

•

Multi-Browser Preview: Multi-Browser Preview provides cross-browser, crossplatform rendering of web pages prior to publishing to the production server or
publish target. Use this to see what your website will look like from the perspective of a
user on a different platform or operating system, including tablets and smartphones.

Previewing the page
The Preview displays what your page — including any recently saved edits or changes —
will look like after it has been published to production server. This is an excellent way to
check links and visually proof the page, making sure the content is styled correctly and that
everything looks good.
Preview mode will also display recently saved assets that have been added to the page,
even if those assets haven’t been published yet. For more information on assets, see pages
65–79.
It’s always a good idea to look at your content in Preview before submitting it for approval.

Editing the page
The Edit button in the Page Action Toolbar displays the page in edit mode and provides
access to the page’s editable regions. Here, you’ll be able to make changes to the content
on your page, add photos and videos to your page, insert assets and snippets, and make
changes to the callouts and calls to action.
For detailed information about editing page content, see pages 30–42.

Adjusting Page Properties
The Properties button in the Page Action Toolbar gives you access to a number of settings
for the page. To access the Page Parameters screen, you must have the file checked out.
There are four categories within the Properties tab:
• Parameters
• Access
• Reminders
• Log
For detailed information about adjusting page properties, see pages 43–51.
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Versions and compare tool

The Versions and compare tool allows you to see and revert to previously published
versions of a page.

To see an earlier version, hover over the Options section of a line and select View > Page.

For an at-a-glance look at the changes between a previous version and the live version,
hover over the Options section of a version and select Compare > Page or Compare >
Page (Hide Includes). The Hide Includes option does not compare such things as header,
footer and navigation.

Use this key when viewing a compared version of a page:
Type of Change
Deletion
Addition or Formatting
Change

Color and Style
Red strikethrough
Green underline

27

The Revert option will replace the current version on the staging server with a previous
version of a page. Although this will not replace a page on the production server until the
page is re-published, use this function with caution, as you may lose unsaved or
unpublished changes.

Page Check

The Page Check button opens a window that can run up to four different checks for your
page.

•

Spelling: Utilizes the OU Campus global dictionary, as well as Hope’s custom sitewide dictionary, to spell check a page.

•

Links: Checks the links for both internal and external links and identifies any broken
links, as well as any warnings.

•

W3C Valid: Identifies any W3C compliance issues with the page.

•

Accessibility: Identifies any issues that may be present relating to accessibility
standards. The report can include known issues, likely issues, and potential issues.

NOTE: We recommend that you always run a spell check before submitting a page for
approval.

28

Save Version

The Save Version button saves the previous version of a page to the Version log.

Submit/Publish

The Submit button sends the page to your approver. In most cases, your approver is
assigned to you in advance; in some cases, you may be able to select an approver on your
own.
After you have sent a file to your approver, you will not be able to make any changes or
edits until your approver either approves and publishes the page or declines the page and
sends it back to you. (The page is considered “checked out” by the approver until further
action is taken.)
For users with publishing rights, this button defaults to Publish, with Schedule, Submit for
Approval and Expire as dropdown options.
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EDITING CONTENT
Editable Regions
Each of your pages includes several editable regions, which are identified and selected with
green buttons that appear after you’ve clicked the Edit button in the Page Actions
Toolbar. If part of the page does not have this green button, it is not editable (or it needs to
be edited in a different part of the CMS, such as the Page Properties section).
For example, the following image shows four editable regions. The content in each region
is edited separately from the other regions. One Edit button corresponds to the left-hand
callout, one is for the introductory content, one is for the main body content, and one is for
the right-hand calls to action.

Clicking an Edit button provides access to edit that area using the WYSIWYG Editor.

Did you just say WYSIWYG?
Yes, this acronym is pronounced whiz-ee-wig and it stands for What You See Is What You Get.
It’s called that because what you see on your screen while you’re editing is what you get on the
live web page. For example, a WYSIWYG editor lets you highlight and italicize text instead of
typing <i>this sort of thing</i> in the source code.

Access to Editable Regions
Your access to editable regions (and the WYSIWYG options in each region) may vary
according to the type of content contained in that region, your role in the publishing
workflow and the level of access you have.
For example, your landing page might need content updates, new images or style
adjustments. The WYSIWYG Editor and default toolbar can provide basic word
processing features such as applying bold and italicized styles, as well as other utilities such
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as adding an image, linking to another page, or inserting an asset or snippet. Alternatively,
a separate element such as a call to action, which has a predetermined style, does not
require full formatting and styling capability. In this case, a modified WYSIWYG toolbar
might only include the capability to modify hyperlinks and perhaps perform limited text
formatting.

Your WYSIWYG Options
When you click on an editable region, a toolbar will appear at the top of the OU Campus
window. This toolbar has a variety of functions that make editing the page easy.
These toolbar icons represent every function available to you. Clicking on any icon
performs an action, either directly to the page or to the selected text or graphics. Some
icons display more options in a drop-down menu fashion, or in a pop-up window display.
In many cases, right-clicking offers contextual functions. For example, right-clicking within
a table provides a list of available table editing and formatting functions.
Additionally, commonly used keyboard shortcuts are available.
Common Keyboard Shortcuts
Cut
Copy
Paste
Bold
Italic
Insert link
Save (without
exiting)
Undo
Redo

CTRL+X, ⌘+X
CTRL+C, ⌘+C
CTRL+V, ⌘+V
CTRL+B, ⌘+B
CTRL+I, ⌘+I
CTRL+K, ⌘+K
CTRL+S, ⌘+S
CTRL+Z, ⌘+Z
CTRL+Y, ⌘+Y

A brief description of each icon's functionality can be found below.
The tools are grouped as follows:
Row 1
•
•
•
•
•
•
•
•
•
•

Save, Exit, Restore
Cut, Copy, Paste
Find and Replace
Undo & Redo
Spellcheck
Clear Formatting
Font Formatting
Lists & Indents
Superscripts & Subscripts
Text Alignment
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•
•

Link Tools
Help Icon

Row 2
•
•
•
•
•
•

Font Properties
Images & Videos
Miscellaneous Functionality
Snippets & Assets
Table Tools
Maximize Content Region

Row 1
Save, Exit, Restore
Icon

Tool
Save

Description
Saves the current file on the staging server and exits the
editable region. Remember, it will not be live on the
production server until it is published.

Exit Without Saving

Exits the editable region without saving changes.

Restore Last Draft

Restores the content to the last point when it was autosaved or when you saved without exiting (CTRL+S, ⌘+S).

Cut, Copy, Paste

NOTE: Many browsers (specifically Firefox, Chrome, and Safari) disable the use of the cut,
copy, and paste commands in the JustEdit toolbar for security purposes. This is not a function
of OU Campus; this is a browser behavior. The alternative workaround is to use keyboard
shortcuts.
Icon

Tool
Cut

Description
To remove content from the document, highlight the
content and click the Cut icon. (CTRL+X for Windows
and ⌘+X for Mac)

Copy

To copy content from the page, highlight the content and
click the Copy icon. (CTRL+C for Windows and ⌘+C for
Mac)

Paste

To paste content on to a page, click the location the content
should be placed on the page and click the Paste icon.
(CTRL+V for Windows and ⌘+V for Mac.)
This pastes only valid content, code and styling and will
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remove any invalid styling from Microsoft Word
automatically. To ensure that the content you’re pasting
from another program, consider first pasting it into a Plain
Text program (e.g., TextEdit) or using the Paste as Plain
Text icon (below).
Paste As Plain Text

To paste as plain text, click the Paste as Plain Text icon.
The icon stays selected until clicked again, and all pastes
going forward until exiting the JustEdit Editor will be plain
text, which removes all formatting.

Undo & Redo
Icon

Tool
Undo

Redo

Description
Click the Undo icon to undo the last changes made in this
session one by one. (CTRL+Z for Windows and ⌘+Z for
Mac)
Redo changes that were previously undone and should be
restored. (CTRL+Y for Windows and ⌘+Y for Mac)

Spell Check
Icon

Tool
Spellcheck

Description
Checks the spelling of the editable region. Misspelled words
are underlined with a red line. Clicking on the word will
bring up the following options:
• A list of suggested words from the dictionary to choose
from
• Ignore the word
• Ignore all instances of that word in the editable region
The drop-down menu on this icon lists the available
languages for which to run the spellcheck.

Clear Formatting
Icon

Tool
Clear Formatting

Description
To remove all formatting for a selection, highlight the text
to be updated and click the Clear Formatting icon. This
returns the selected text back to the default settings.
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Font Formatting
Icon
Bold

Tool

Description
Applies bold formatting to selected text. (CTRL+B for
Windows and ⌘+B for Mac)

Italic

Applies italicized formatting to selected text. (CTRL+I for
Windows and ⌘+I for Mac)

Lists & Indents
Icon

Tool
Bulleted list

Description
Turns the selected text into a bulleted list. Example:
• Apples
• Oranges
• Bananas

Numbered list

Turns the selected text into a numbered list:
1. Click the Go button
2. Enter the text to search for
3. Click Start

Decrease indent

Decreases the indent of a paragraph. Each consecutive click
moves text further to the left.

Increase indent

Increases the indent of a paragraph. Each consecutive click
moves text further to the right.

Block quote

Block quote is a block-level element in HTML that can be
used to set off quotations or to cite material.

Superscripts & Subscripts
Icon

Tool
Superscript

Description
Formats the selected text as superscript text.

Subscript

Formats the selected text as subscript text.
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Text Alignment
Icon

Tool
Align Left

Description
Aligns a block-level element such as a paragraph or a
heading to the left margin.

Align Center

Center aligns a block-level element such as a paragraph or a
heading within the left and right margin.

Align Right

Justify

Aligns a block-level element such as a paragraph or a
heading to the right margin.
Justifies text making it flush on both the left and right side.

Link Tools
Icon

Tool
Insert/Edit Link

Description
To create a hyperlink:
1. Select the text or image for the link
2. Click the Insert/Edit Link icon
3. Enter an external URL or click the Browse icon to
select an internal page to link to
4. After locating the file, click Select
5. Enter in the Text to display and the Title for the link
6. Click Insert
To edit a hyperlink, click on the text or image that is linked
and then click the icon.
If you’re linking to a page or file in OU Campus,
dependency tags (e.g., {{f123456}}) may be shown
instead of URLs.

Remove Link

Select a link in the editable region and click the Remove
link icon to remove a hyperlink.
Note: For anchors, the Remove Link icon works with anchors in
Internet Explorer. It will not work on anchors in Firefox, Safari, or
Chrome.

Insert/Edit
Mailto Link

To create a mailto link, select the text or image for the link, then
click the Insert/Edit Mailto Link icon. Then, enter the email
address and default subject of the email.

To edit a mailto link, click on the text or image that is
linked and then click the icon.
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Insert/Edit Anchor

To create an anchor:
1. Position the cursor where the anchor should be placed
or select the text or image
2. Click the Insert/Edit Anchor icon
3. In the Name field, enter the name for the anchor; the
hash mark (#) is generated automatically
4. Click OK
To modify an existing anchor:
1. Click the existing anchor shown in the editing area
2. Click the Insert/Edit Anchor icon on the toolbar
3. Edit the name of the anchor and click OK

Help Icon
Icon

Tool
Help

Description
Displays a window with references for all icons in your
toolbar.

Row 2
Font Properties
Icon

Tool
Paragraph

Description
The Paragraph drop-down menu lists the block-level styles
that can be applied to a selected paragraph including
headings. To apply an element from the Paragraph dropdown, click within the paragraph (or select text), and then
click the element from the drop-down.
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Style

The Styles drop-down menu lists the custom CSS styles
made available to the page. To apply an element from the
Styles drop-down menu, highlight text or select an image in
the WYSIWYG Editor and click the element from the
drop-down.

Images & Videos
Icon

Tool
Insert/Edit Image

Description
Allows users to insert an image on a page by browsing for a
previously uploaded image or using the Upload/Upload
and Edit features to upload and then place an image.
Clicking the icon will bring up a modal where users can
alter the dimensions, description, tooltip, class, alignment,
and more of the image.
Tip: We recommend sizing, editing and formatting images before you
upload them to OU Campus if possible. You can use the OU Campus
editor if you want, but many people find it easier to use Photoshop or
another dedicated photo editing tool.
Find more information about Images on page 81.

Insert/Edit Video

Allows users to insert a video on a page by pasting a link
from a video hosting site such as YouTube or Vimeo or
browsing for a video uploaded into OU Campus. Clicking
the icon will bring up a modal where users can alter the
dimensions of the video, provide an embed code and more.
Tip: We recommend using the YouTube Gadget, which allows you to
select from the Hope College and Hope College Athletics, or search for
and enter video hosted on a different channel.
Find more information about videos on page 99.
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Miscellaneous Functionality
Icon

Tool
Insert Horizontal
Line

Description
Adds a horizontal line to the page. (This is the same as
entering <hr/> into the source.

Insert Line Break

Inserts a line break. (This is the same as entering <br/>
into the source.)

Insert Special
Character

Inserts a special character such as ©, ®, or other
symbol. The Special Character modal provides a selection
of 200 special characters to choose from. Hover or use the
left and right keyboard arrows to navigate the selection.
Click a character to add it to the page and close the modal.

Show/Hide Blocks

Toggles the WYSWISYG view to show or hide block-level
element labeling. Each element such as <p> or
<blockquote> is displayed encapsulated with a thin
border and labeled with a small tag.

Snippets & Assets
Icon

Tool
Insert Snippet

Description
Click the Snippets icon in order to add preexisting snippets
of HTML or text into the page. Snippets shown in the
window can be filtered and previewed before being placed
on the page. Find more information about Snippet on
page 54.

Insert Asset

Click the Assets icon in order to add a preconfigured asset
into the page. Assets shown in the modal can be filtered and
previewed before being placed on the page. Find more
information about Assets on page 66.
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Table Tools
Icon

Tool
Table
DropDown
Menu

Description
Note: We recommend using one of the two Table Snippets instead of
inserting a new table, as they are already formatted with pre-defined
styles.
To insert a new table, hover over Insert Table and then use
the mouse to select the correct amount of rows and
columns. Clicking will create the table.

This button brings up a new window where users can
modify the properties of a table.
Clicking this button will bring up a new window where
users can modify the properties of a table. The General
Tab contains basic options like table dimensions, cell
spacing and padding, border width, toggling a table
caption, table alignment and setting a custom CSS class for
the table.
General Tab
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The Advanced Tab allows users to set styling for the table
as well as border and background color.
Advanced Tab

Click to delete the selected table.
The Show Table Outlines icon adds/removes the outlines
of tables that would be invisible otherwise, for visual
purposes only. These lines disappear when the editable
region is saved and the page is viewed in Preview.
This menu contains three options:
• Cell Properties
• Merge Cells
• Split Cells
Cell Properties brings up a modal similar to the Table
Properties modal above. Merge Cells will merge the
selected cells together, and Split Cell will separate a
previously merged cell into its original cells.
This menu contains the following options:
• Insert row before
• Insert row after
• Delete row
• Row properties (bringing up a modal similar to the
Cell Properties and Table Properties modals)
• Cut row
• Copy row
• Paste row before
• Paste row after
This menu contains three options:
• Insert column before
• Insert column after
• Delete column
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Maximize Content Region
Icon

Tool
Maximize Content
Region

Description
Expands the editable region to fill the width of the frame
window. This is particularly useful when editing table
transformations, where the table is extremely wide in the
Editor but the transformed content fits more nicely into the
editable region on the page.

Copying and pasting text
Many of us write our content in a separate program (e.g., Microsoft Word, Google Drive)
and then import it into OU Campus. There are several ways to copy and paste text into an
editable region on your page.
1. Use keyboard shortcuts.
• Cut: CTRL+X for Windows and ⌘+X for Mac
• Copy: CTRL+C for Windows and ⌘+C for Mac
• Paste: CTRL+V for Windows and ⌘+V for Mac
2. Use the WYSIWYG toolbar.
•

Cut:

•

Copy:

•

Paste:

When copying and pasting text into an editable region, it’s important that you not paste
the styles from a word processing program into the page. Doing so can change the format
of your web content.
•

Copy and paste into a plain text program (e.g., TextEdit), then copy and paste into
OU Campus.

•

Use Paste as Plain Text

in the WYSIWYG toolbar.
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Using anchor links
An anchor link directs users to a particular heading or section on a particular page. To
insert or modify an anchor link, follow the steps on page 36. To link to an anchor:
•

If you’re linking to an anchor on the same page you’re currently working on, select the text
you’d like to link and click the Insert/Edit Link button in your WYSIWYG toolbar. Either
manually type a hashtag followed by the anchor name in the URL field
(e.g., #scholarships) or select the correct anchor from the dropdown menu.

•

If you’re linking to an anchor on a different page than the one you’re currently working
on, select the text you’d like to link and click the Insert/Edit Link button in your
WYSIWYG toolbar. Insert URL or a dependency tag followed by a hashtag and the
anchor name in the URL field. For example, {{f:7100519}}#scholarships or
http://www.hope.edu/academics/history/index.html#scholarships.

42

ADJUSTING PAGE PROPERTIES

The Properties button in the Page Action Toolbar gives
you access to a number of settings for the page. To access
the Page Parameters screen, you must have the file
checked out.
There are four categories within the Properties tab:
• Parameters
• Access
• Reminders
• Log

Page Parameters
Page Parameters gives you access to several types of settings. Many of these settings modify
the information you provided when creating the page.
• Title and Meta Tags
• Custom Settings
• Page Options
• Map
• Blog
• News and Events
• By the Numbers
• Administrator Overwrites

Title and Meta Tags
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Custom Settings

Page Options

Depending on the template you’re using, a variety of page options will be available to you.
Clicking the checkbox next to an option turns it on or off on your page.
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Page options include:
•

Banner events are available for Landing Section or Landing Page templates.
Selecting this option will display the next five events in the Hope College calendar that
are tagged with your section (e.g., Academics, Biology) and set as featured events.

•

Introduction text is a paragraph of large type that precedes and introduces the main
content of the page.
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•

Left Column Navigation turns on or off the
section navigation that appears to the left of the
content. Except in very rare instances, this box
should always be checked.

•

Left Column Callout provides additional
information on the left-hand side of the page. This is
formatted as a snippet; see Left Column Callout in the
Snippets section on page 54 for more information.

•

Left Column Contact Info is auto-generated from
our database. Any edits to this information will need to
be done through CIT and applied universally
wherever the information is used on campus. If you
would like a different department or office listed than
the one automatically assigned to your page, talk to
Public Affairs and Marketing.

•

Left Column Additional Content provides an additional field on the left-hand side
of the page, below the contact information. Unlike the other Left Column sections, this
one does not come pre-populated with a snippet; instead, you’ll have to add a Left
Column Callout or Department – Social Media snippet on your own. See page the
Snippets section on page 54 for information about adding a snippet to this section.

REMINDER: The options above can be turned on or off in page properties under
“Parameters.”
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•

Right Column Call to Action checkbox enables
the calls to action section at the top of the right-hand
side of the screen.

•

Right Column Event displays the next listing from
the Hope College calendar of events that matches
the site section of your page (e.g., Academics,
Research).

•

Right Column News displays the most recent
news item that matches the site section of your page
(e.g., Academics, Research).

•

Right Column Email Sign-up enables a field that
allows users to sign up for a department or office
email newsletter. If you enable this checkbox, you’ll
see a red placeholder in the right-hand column.
Contact Public Affairs and Marketing to set up your
newsletter subscription.

•

Right Column Additional Content adds a blank editable region below the other
right-column information. Like the Left Column Additional Content field, you’ll have
to insert your own snippet in this region. See page 54 for more on inserting snippets.
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•

By the Numbers are the number-based facts toward the bottom of some pages.
Clicking the checkbox turns this feature on or off. For information about adding By
the Numbers, see page 50.

•

Twitter adds a field toward the bottom of the page that features a tweet (or a
selection of tweets).

•

Quote adds a field toward the bottom of the page that features a quote (or a selection
of quotes).

REMINDER: The options above can be turned on or off in page properties under
“Parameters.”

LDP Gallery Type
This dropdown menu allows you to toggle the format of an Image Gallery asset placed on
your page. For more information about Image Gallery assets, see the Assets section on
page 66.
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Map

If you would like a map in the right-hand column, enter the address or GPS coordinates in
the Map Location field. The map link defaults to Google Maps; we recommend that you
enter a link to the Hope College campus map, maps.hope.edu, into the Map Link field.

NOTE: First, ask whether you really need to have a map on this page.
Blog

Several departments and offices maintain a blog. To automatically populate the six most
recent blog posts on a page, enter the necessary information into these fields.
The Blog URL field should include the link to a blog XML feed — not a link to the blog’s web
address itself. To get this URL, visit the blog and then click “Subscribe” or “Entries RSS”
(or a similar link) to gain access to the XML feed. For example, the student blog URL on
the Admissions page is https://blogs.hope.edu/students/feed/.
Enter a Blog Heading to customize a header for this section of your page.
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News and Events

If your page template has an option to include News and Events at the bottom of your
page, you can enable the options here. Landing Section and Landing Page templates
include this option. The default is None.
Selecting News and Events will display the three latest news stories from your section and
the next two upcoming events; selecting Events Only will display the next five upcoming
events.

NOTE: This is distinct from the Featured Events at the top of some pages, which displays the
next five upcoming events marked “Featured.”

By the Numbers

To enable By the Numbers on your page, select the By the Numbers checkbox in the Page
Options above.
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Factoids must be created and published before you can include them on your page. You
can use an already existing factoid, or you can create a new one using the steps on page
21. Once the factoids have been published, use the File Chooser to navigate to and select
the correct factoid for each of the four fields.

Administrator Overwrites
Access to Administrator Overwrites is limited to certain individuals. Contact Public Affairs
and Marketing if you want to change any of these variables or have any questions.

Access
Site Administrators can use the Access settings to modify
which user groups have access to a page, change the toolbar
options and perform other administrative functions.

Reminders
Use the Reminder page to set a scheduled or stale reminder
for when you need to update content.

Log
The Log window shows previous activity (such as saves and publishes), identifies the user
who made the changes and records the date and time of the changes.
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SUMBITTING PAGES FOR APPROVAL
The Hope College workflow requires all content from users to be submitted to an assigned
approver before the page is published. The approver will then have the option to Publish
or Decline the page.
In order to submit for approval, you must first check out the content. If you do not have
direct publish permissions, you will see a Submit button in the Page Actions toolbar.

Users who do have direct publish permissions can still submit content edits for approval.

When a page is submitted for an approval, the page will automatically be checked out to
the approver. The Pending Approval status will show in both the user and approver's
Workflow.
After the Submit for Approval button is clicked, the Submit for Approval modal appears.
It includes the following items:
•

To: If you have a drop-down
menu, you can use it to select an
approver to send the content for
review. If the drop-down is
unavailable, then the content
must be sent to the pre-selected
approver.

•

Subject (required): A brief
subject used to help identify the
file for review.
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•

Message (optional): Users enter a brief description in the text field to help
approvers identify the changes that have been made.

•

Send Copy to Email: Sends an email to the approver's external email address in
addition to the internal OU Campus message received in the approver's Inbox.

After this information has been entered, click Submit to submit the content for approval.

Sending for Approval
Both pages and binary files can utilize the approval workflow.
1. Navigate to the Pages list view by selecting Content > Pages from the global navigation
bar. Additionally, expanding the File Navigation sidebar displays a list of the available
pages.
2. Select a page from the Pages list view and hover over the row. Choose Submit For
Approval from the Publish menu.
Alternatively, clicking the linked file name from the list view or the sidebar will display the
page and the Page Actions toolbar. From the toolbar, click the arrow on the Publish
button to reveal additional publishing options including Submit For Approval.

3. Select the user from the drop-down next to the To field. If an approver has been enforced,
the To field is auto-populated and there will not be a drop-down available.
4. Fill out the necessary text fields.
5. Optionally, select Send Copy to
Email to allow the request for
review to be sent to the user’s
external email address. This
allows users to receive a
notification that action is to be
completed, without having to log
into OU Campus. Clearing this
option will only send the message
through the OU Campus system.
6. Click Submit.
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SNIPPETS
Snippets are reusable files that will allow you to create customized content in a specific
format. Once a snippet is inserted on a page, it can be edited without modifying the
original snippet.
There are multiple snippet types, including:
• Accordion
• Call to Action
• Callout
• Social Media listing
• Tables
Unlike assets, which can be edited once and those changes applied to all subscribed pages,
editing a snippet does not change pages on which the snippet has already been placed.
You can insert a snippet on a page by selecting the Snippet icon on the WYSIWYG
toolbar, then a category and a snippet from the following window. Alternatively, you can
use the Snippet Gadget to drag a snippet into a page via the WYSIWYG Editor. You can
then edit it.
When editing within the WYSIWYG Editor, a snippet becomes part of the page.
The Snippets screen includes the following features and functionality:
• Lists the number of snippets
• The list can be filtered and sorted
• The ability to add a new snippet
• Editing the snippet configuration by clicking the linked snippet name
• Previewing or deleting a snippet
• Clicking through to edit the snippet file
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Inserting a snippet using the WYSIWYG toolbar
To insert a snippet onto a page using the WYSIWYG toolbar:
1. Enter an editable region to edit the page.
2. Click the Insert Snippet button

in the WYSIWYG toolbar.

3. Use the Choose Snippet window to find your Snippet.

4. If necessary, use the Filter bar to find the snippet you’re looking for.
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5. Click on a snippet's name to preview it.

6. Add the snippet to the page using one of the following methods:
• Click the Insert button
• Double-click the snippet name
7. The snippet is now part of the page and can be edited without affecting the original
snippet.

Inserting a snippet using the snippets gadget
The Snippets Gadget allows users to add previously
created snippets into an editable region. Its drag-anddrop functionality helps streamline the workflow process
when adding snippets to a page.

NOTE: Remember that the Snippets Gadget does
not appear in the Gadgets sidebar until an editable
region has been opened in the WYSIWYG Editor.
In the Snippets Gadget, users can filter the list of
snippets by snippet category. All snippets are shown by
default. Choose a category from the drop-down to view
all the snippets assigned to that particular snippet category.
Hope College users will most often use snippets in the Standard category.
To insert a snippet onto a page using the Snippets Gadget:
1. Enter an editable region to edit the page.
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2. If the Gadgets sidebar is not visible, click the Show Gadgets icon to show the sidebar.

3. Expand the Snippets Gadget.

4. If necessary, select a snippet category from the categories drop-down.

57

5. Click on a snippet's name to preview it.

6. Add the snippet to the page using one of the following methods:
• Click Insert from the preview screen
• Double-click the snippet name
• Drag the snippet onto the page
7. The snippet is now part of the page and can be edited without affecting the original
snippet.

Accordion snippet
The accordion is a table that expands and contracts to show or hide information. It can be
useful for organizing and displaying large amounts of information.
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The accordion styles are set by a simple pattern of alternating rows: The first row is the
Title field, the second row is the Content; the third Title, fourth Content; and so on in
pairs.

To change content, simply highlight and replace the default lorem ipsum text with your text.
To add additional accordion headers, use the Table Tools to insert two additional rows for
the Title and Content; rows will be formatted automatically. You can also use the Table
Tools to delete rows in pairs.
Access Table Tools via the WYSIWYG Toolbar or by right-clicking within the table itself.
For more information about Table Tools, see pages 39–40.

TIP: To format accordion lists as a double
column, add the ul.column-list class to the
source: <ul class="column-list”>
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Call to Action snippet
A call to action is formatted to stand out from the rest of the page content. Its color is
automatically set according to the main navigation category of your page (e.g., Academics,
Arts, Research, etc.). A call to action should always contain a call to action, something you
want your audience to do — download this, visit that, explore more and the like.
Calls to action will most often be used in the right column of the page, but may also be
used in the main body content.

Right-hand sidebar

Main body content

For many page templates, calls to action are automatically added when you create the
page. To edit the call to action, select Edit from the Page Action Toolbar, then click the
green Edit Call to Action button to select the editable region.
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To change the text, simply highlight the default text and replace it with your new call to
action. To add a link, click anywhere within the call to action text and select the
Insert/Edit link button from the WYSIWYG toolbar:

If calls to action are not enabled, you can do so in the Page Properties section: Check out
the page, click Properties in the Page Action Toolbar, then click the Right Column Call to
Action checkbox.

To insert a new call to action in the Right Column Call to Action field or in the main
content, follow the steps on pages 55–58.
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Callout snippet
The left-column callout is designed to provide additional
information related to your page. Its location gives it a
higher profile than the standard body content, but the textonly formatting makes it stand out less than a call to action.
It is most often used to provide additional information. The
callout style matches the style of the contact information.
For many page templates, a callout is automatically added
when you create the page. To edit the callout, select Edit
from the Page Action Toolbar, then click the green Edit
Callout button to select the editable region:

To change the text, simply highlight the default text and replace it with your new
information. To add a link, highlight the text you want linked and select the Insert/Edit
link button from the WYSIWYG toolbar:

If calls to action are not enabled, you can do so in the Page Properties section: Check out
the page, click Properties in the Page Action Toolbar, then click the Left Column Callout
checkbox.

To insert a new call to action snippet in the Left Column Callout field or in the Left
Column Additional Content field, follow the steps on pages 55–58.
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Department – Social Media snippet
The Department – Social Media snippet was designed to give users easy access to
department or office social media accounts (as distinct from the Hope College accounts
linked in the footer of every page).
Department – Social Media snippets were designed to be placed in the Left Column
Additional Content field, which will be located below the Left Column Contact Info field
after you activate it. The snippet can also be placed in the Left Column Callout and Left
Column Contact Info fields.

The Left Column Additional Content field is not activated when you create a page. To
add it to your page, check out the page, click Properties in the Page Action Toolbar, then
click the Left Column Additional Content checkbox.

To insert the snippet, follow the steps on pages 55–58.

63

After you’ve inserted the snippet, delete the placeholders for any social media accounts you
do not want listed on your page.

To change the text, simply highlight the default text and replace it with your new
information. To add a link, highlight the text you want linked and select the Insert/Edit
link button from the WYSIWYG toolbar:

Table snippets
For your convenience, there are two pre-built table formats for the Hope College website.
These two formats are accessible as two snippets: Table Style 1 and Table Style 2.
Table Style 1 has headers for columns and rows:
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Table Style 2 has headers for columns only:

To place a table on your page, insert the Table Style 1 or Table Style 2 snippet into the
main content region following the steps on pages 55–58.
To change the content, simply highlight and replace the default column label, row label or
lorem ipsum text with your own text.
Use the Table Tools to add additional rows or columns; row and/or column headers will
be formatted automatically. You can also use the Table Tools to delete rows or columns.
Access Table Tools via the WYSIWYG Toolbar or by right-clicking within the table itself.
See Table Tool information on pages 39–40.
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ASSETS
What is an asset?
An asset is reusable content in one location. Users can place an asset on an unlimited
number of pages, which is convenient when working with multiple pages that require the
exact same information. Asset content is created and edited in one place (the Asset
Manager) and populated automatically on all subscribing pages. This way, you only have
to edit or update information in one place and it will automatically appear wherever the
asset is included.
Assets can be easily inserted on a page via the WYSIWYG editor. Access to and use of
some assets may be limited according to which type of editable region you’re working in.

Types of assets
Five types of assets are available:
• Web Content Asset
• Plain Text Asset
• Source Code Asset
• Image Gallery Asset
• Form Asset
The two Asset types that are most commonly used for the Hope College website are Image
Gallery and Plain Text Assets. Image Gallery assets are used to create thumbnail galleries,
photo sliders and the banner images at the top of pages.

Using Asset Manager
To access the Asset Manager, select Assets from the Content dropdown menu in the global
navigation menu.

Managing assets is similar to managing pages. Like pages, the availability of functionality is
dependent upon access settings and level of access.
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Assets List View

The Assets list view displays the following features and functionality:
•

Number of assets: The assets displayed are affected by user access settings and
access settings.

•

Filter: Assets can be filtered by name, site, asset type or asset tags. Clicking into the
Filter bar will bring up the top five sites with the most assets, the tags denoting asset
type, and the top ten most commonly used tags. More than one term can be used at a
time to filter the list view.

•

New button: This allows users to create new assets. The ability to create new assets
may be restricted according to your role and/or the level of access you’ve been
granted to the site. (For more information on creating a new asset, see page 70.)

•

Asset List: The list contains sortable headers for asset type, name, status, asset
dependency tag, date/time of the last modification and the site in which the asset was
created. Hover over a row to display more options and actions.
The Asset List includes the following columns:
• Checkbox: Allows users to select multiple assets.
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•
•
•

•
•
•

Asset Type: An icon that denotes the asset type.
Name: The user-friendly name assigned during asset creation. Click the
hyperlinked name to go to the edit view for the asset.
Tag: The asset tag is a unique identifier for assets within an account and can be
used to search for an asset and is available for reporting purposes. This is similar to
how Dependency Tags work for files and pages. Asset tags are wrapped in double
curly braces and take the format of a:1234.
Status: Denotes the current status of the asset (i.e., checked in, checked out,
locked, awaiting approval or a scheduled action).
Modified: The date and time the asset was last saved.
Site/Options: The OU Campus site in which the asset was created. When users
hover over the asset row, additional options appear under this heading.

Asset Options
A variety of options are available for an asset under the Site/Options table heading the
when a user hovers over an asset row. The available actions vary depending on the user's
permission level as well as the status of the file (i.e., checked in or checked out, locked,
pending an action).

In general, Edit, Review, Publish and File menus are available:
Edit M enu

Use this to edit general content and properties for the asset. Available actions are:
•

Asset: Allows you to edit the content of the asset.

•

Properties: Allows you to edit general properties and metadata for the asset. The
Properties view may also give some users access to the Access Settings and the Log
screens for the asset. This option is only available if the asset is checked out.

•

Access: Allows you to assign access settings, including the groups whose members
have access to edit and use the asset, enforced approvers and bypass approval groups.
This function is limited to users with administrator approval.
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Review M enu

Use this to preview the asset and its previous versions. Available actions are:
•

Preview: Provides a view of the finished asset as it would appear in the OU Campus
system.

•

Save Version: Saves the current state of the file to the versioning system (only
available when the file is checked out).

•

Versions: Allows you to view and revert to previously saved versions of the asset from
the versioning system (only available if the asset is checked out).

NOTE: The ability to compare asset versions is currently not available for Forms or Image
Galleries.
•

Log: Provides a list view of the history of actions performed on the asset.

•

Form Submissions: This option is only available for Form Assets, and it allows
users to view all form submissions.

Publish M enu

Use this to access publishing options for the asset. Available actions are:
•

Submit for Approval: For most users, the asset can only be sent to your assigned
approver. Allows users to send the page to another user in the OU Campus system for
review.

•

Publish: Available only to users who do not have an assigned approver. Immediately
publishes the asset. Publishing an asset updates the asset on all subscribing pages, using
the currently published version for the update. Subscribing pages that are checked out
or otherwise involved in a workflow will be updated with the updated asset content,
but will not be published until that page is manually re-published. Multiple assets can
be published simultaneously by selecting the checkbox next to each desired asset and
clicking Publish in the table header.
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•

Schedule: Allows users to define a future date that the asset will auto-publish to the
production server or publish target. (Access rights for scheduled publish are the same
as those for regular publish.)

File M enu

Allows users to perform additional actions on the asset. The available actions are:
•

Rename: Allows users to rename the asset (only available for certain users).

•

Copy: Allows users to copy the asset (only available for certain users). This option is
not available for Form assets.

•

Delete: Allows users to delete the asset (only available for certain users). Pages
subscribing to the asset will become broken until the asset is removed from the page.
Multiple assets can be deleted at the same time by selecting the checkbox for each
desired asset and clicking Delete in the table header.

How to create a new asset
The basic steps for creating an asset are the same for all assets types. Most users have the
ability to create new assets. If you need help creating an asset, contact Public Affairs &
Marketing.
Depending upon the asset type being created, the available fields and options will vary.
Once an asset has been created, it is available for inserting onto a page via the WYSIWYG
Editor or Source Editor in accordance with any access settings that may be configured.

Creating a New Asset
To create a new asset:
1. Navigate to the Assets list view by selecting Content > Assets from the global
navigation bar.
2. Click the New button or the down-arrow.
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3. Select the asset type from the menu that appears, whether it is the dropdown or a new
modal.

New asset dropdown

New asset window
4. Configure the necessary settings in the Asset Info Panel, Access Settings Panel and
Asset Content Panel (see below for more information about each panel).
5. Click Create.
6. Publish the asset. An asset must be published to the production server or publish
target to update content on pages. An asset may be inserted on a page without
publishing, but the content will not update the page on the web server. After using the
asset on a page, the page must be published to update live version of the page.
Asset Info Panel

71

The Asset Info panel allows users to configure basic metadata properties of an asset,
including:
•

Asset Name: A friendly name that will be displayed through the whole system. This
should clearly indicate the content of the asset.

•

Description: The description can also be useful when selecting an asset from the
Asset Browser (hovering over an asset to see its description).

•

Tags: Tags can be added during asset creation or editing. These can be used to filter
a list of assets. For example, a photo gallery of Dimnent Memorial Chapel might
include the tags building, chapel, dimnent and gallery.

•

Lock to Site: Select the checkbox to prevent the asset from being used outside of the
site (hope.edu). In other words, assets are available to all sites within the Hope College
account unless this checkbox is selected. Form and Image Gallery assets are always
locked to the current site.

Access Settings Panel

The Access Settings panel allows some users to configure the access settings for editing and
using the asset. The Access Settings panel contains the following items:
•

Access Group: Assigns an access group. The default group. “Everyone,” indicates
that every user within the account can edit the asset from the Access screen.

•

Available To: Assigns an access group whose members can use (insert on a page) the
asset. The default, “Everyone,” indicates that every user within the account can insert
the asset into a page via the WYSIWGY Editor or the Source Editor.

After the asset has been saved, additional settings include Approver, Enforce Approver
and Bypass Approval. These can be configured via the assets action view in the Properties
menu.
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Asset Content Panel

The Asset Content panel is available for Web Content, Source Code and Text assets. It
allows users to create the actual content of the asset. The functionality of this panel
depends upon asset type. This panel is not used for Image Galleries and Forms.

Creating a Plain Text asset
Plain Text assets are used for creating assets with plain text that do not include HTML.
They are created and edited with the plain text editor. This type of asset is available across
sites within an account unless Lock to Site is selected.

1. Navigate to the Assets list view by selecting Content > Assets from the global
navigation bar.
2. Click the New button.
3. Select Plain Text from the menu to display the New Plain Text Asset screen.
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4. Fill out the required fields. For this particular asset, the Asset Content Panel will
contain only plain text. Any markup language is not included on the page as text.
5. After configuring the items click Create.
6. Once the asset has been created, Publish the asset or Submit for Approval.
Like pages, created and saved assets can be immediately published, scheduled to publish,
or sent to user for approval. An unpublished asset can even be inserted into pages;
however, an asset will not render on the production server until it has been published.
Inserting a Plain Text Asset to a Page
Once a Plain Text Asset has been created, it is available to be inserted on pages within OU
Campus. Unlike most other asset types, a Plain Text Asset will render inside the
WYSIWYG editor as a green box with the plain text content defined by the creator.

When added to a page, any text within the asset’s content will be displayed where the asset
has been inserted.

Creating an Image Gallery asset
Creating an Image Gallery Asset is a little different than creating other assets, as it is a twostep process.
The first step is to create the asset; when creating a new Image Gallery, users will first fill
out basic information, just like other asset types (see Creating a New Asset on page 70).
The second step is to upload images into the asset, sort them, add captions, titles and
descriptions if desired, and then finally save and publish the asset. At this point, the asset
can be inserted on a page.
Basic Steps
1. Navigate to the Assets screen and click the New button or dropdown.
2. From the New Asset window or dropdown, select Image Gallery.
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3. On the New Image Gallery screen, fill out the information in the Asset Info, Access
Settings, and Gallery Options panels. When initially configuring the Gallery Options
or when editing them later, use either the Set or Save buttons to commit the changes.
4. Click Create. The Images panel becomes available.
5. Add the images to the asset, including the metadata details. Depending on how the
image gallery is displayed on the page, the title, description, caption and/or link fields
will appear with the images in the gallery.
6. Click Save.
7. Click Publish or Submit for Approval.
While an asset can be inserted on a page before the asset has been published, the asset
must be published in order for it to render properly on any subscribing pages.
New Image Gallery screen
The New Image Gallery screen includes the following panels:
•

Asset Info: Allows users to name the asset, add a description and add tags to the
asset. The Lock to Site checkbox is also present in this panel, though Image Gallery
Assets are always locked to the site in which they were created (hope.edu).

•

Access Settings: Allows users to configure who can edit the asset (through the Access
Group drop-down menu), and who can place the asset on a page (through the
Available To drop-down menu). If you belong to multiple groups, use these settings to
choose which of your groups should have access to the asset.

•

Gallery Options: Allows users to configure the thumbnail options and add any extra
XML in the Advanced field.

•

Images: Available after the asset has been initially created. Allows users to add
images to the gallery, reorder them, and add metadata such as title, description,
caption, and link.
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Gallery Options panel

The Gallery Options panel includes the following:
•

Maximum Thumbnail Size: Customize the maximum thumbnail dimensions at
which the thumbnails display. At Hope College, this should be 310W x 310H.

•

Thumbnail Preview: A gray box placeholder of the size and aspect ratio chosen for
the thumbnail previews.

•

Thumbnail Aspect Ratio: Used to choose the between using the aspect ratio of the
image's original dimensions or cropping the image. For images on the Hope College
website, select the Crop option.

•

Advanced: The Advanced field populates the <advanced> node of the image
gallery XML, can be used to define extra XML as necessary and can be used in
conjunction with XSL to extend the capabilities of the gallery.

76

Images panel

Once the asset is created, the Images panel is available for adding images. Images can be
uploaded from the local computer by clicking Add and selecting the files or by simply
dragging and dropping onto the panel.
After images are added, users can add metadata for each image. This metadata will be
used by the various gallery display types available in the site and rendered along with the
image gallery on the published page. Users also have the option to show or hide the
metadata fields by clicking the Full View and Compact View buttons, respectively, in the
top right of the panel.
When an image is added to the Images panel, a thumbnail of each image is displayed with
the following:
•

Title: The name of the image.

•

Description: Enter a brief description about the image; used only for accessibility
and search purposes.

•

Caption: Enter a caption for the image.

•

Link: Users have the option to also include an HTML link by manually entering the
web address in the text field. If used, clicking the image on the published page will take
users to the defined link.
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Special functions
•

Orange action button: To insert an orange action button, type button="text";
into the Description field, then type the dependency tag or URL for the destination
page into the Link field. Note that quotation marks and semicolon are part of the
code.

•

Thumbnail image: To insert a thumbnail image in a banner gallery, upload and
publish the thumbnail image separately; copy the file’s URL or dependency tag (e.g.,
{{f:7962363}}); then type thumb="URL or dependency tag"; into the
Description field. Note that quotation marks and semicolon are part of the code.

•

Banner height: Use the Advanced field to change the height of a single banner
image at the top of a page. Type size="small"; to use the department-banner class
(390 pixels high) or size="large"; to use the section-banner class (620 pixels high).
Note that quotation marks and semicolon are part of the code.

•

Thumbnail caption: To insert a caption on the thumbnail image in a banner
gallery, type photocapt="adds a caption to home banner thumb”; in the
Description field. Note that quotation marks and semicolon are part of the code.
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Adding, deleting, and otherwise modifying images
Images can be removed by clicking the X in the top right of each image box. Additional
images can be added at any time by clicking the Add button or dragging and dropping
images into the Images panel. Metadata for existing images can be edited as well.

NOTE: You can also add or remove images from the gallery after it has been created and
published. Just open the asset, check it out, and select the Edit button in the Page Actions
Toolbar, then follow the steps above.
Once the images have been added, deleted or edited, save the gallery asset. The asset will
need to be republished for changes to be reflected on the live site.
Reordering Images
The order that the images are placed within the gallery, by default, determines the order
within the gallery or slider. To change the order of an image:
1. Hover over the image.
2. Click and drag it into the new location.
3. Repeat as necessary with other images.
4. Click Save.
5. Publish the asset.

Using assets on your page
In order to insert an asset into a page or editable region, it must first be created within a
site in the OU Campus system.
Assets are inserted on a page while editing in the editable region. Once a page has
subscribed to the asset, any time the asset is changed and republished, the subscribing page
will also be republish to reflect these changes.
1. While in an editable region, place the cursor where the asset will be entered.
2. Then find and click on the Insert Asset icon in the WYSIWYG toolbar.
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3. Choose the asset from the list of available assets in the Asset Browser. You can filter the list
by tag, type, or site.

4. Click on the Insert button.
The asset will be entered into the page where the cursor was placed. If the asset is an
Image Gallery, it cannot be previewed in the WYSIWYG Editor, but it will still have a
wrapper. Note that even though the asset is not displayed in the WYSIWYG Editor, most
will still render in the page Preview.
To delete an asset from a page in the WYSIWYG Editor, click anywhere on the asset
wrapping and press the Delete key.
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IMAGES
Recommended size and resolution
All photos should be a resolution of 72 pixels per inch and a file size of 500KB or smaller.
We highly recommend optimizing images for the web through Photoshop's Save for Web
function or a similar method.
Size your photos to the following dimensions:
• Homepage Banner: 1400 x 750
• Homepage Banner Popups: 389 x 213
• Section Banner: 1400 x 620
• News Banner: 1400 x 620
• Calendar (Localist) Event: 1000 x 450
• Department Banner: 1400 x 390
• Directory Office Banner: 1200 x 425
• Directory Building Banner: 860 x 345
• Directory Person Headshot: 340 x 340
• Main Content Inline Images: 800 max width
• Photo Gallery Slideshow: 655 x 400
• Photo Gallery Grids: Any size up to max of 1200 x 800; set asset thumbnail size to
310 x 310

Uploading an image
NOTE: All images must be published to the production environment before they
appear live on the website. If you upload an image to the staging environment but do
not publish it (or submit it for your approver to publish), it may not appear in your
Preview screen and will not appear on the website.
You can upload an image in one of two ways:
In the Pages list view:
1.

Navigate to the images folder in your department or office section, and then click the
Upload button.
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2. For Type, choose Upload Files. (To upload and edit the image, select Edit and Upload
Image; see Editing images on page 83 for more information.)

W hile inside an editable region:
1.

Click the Insert/Edit Image button in the WYSIWYG toolbar and browse for a file.

2. In the Select Image modal, click Upload (to upload and edit the image, select Upload
and Edit; see Editing images on page 83 for more information). Make sure you upload
it to the correct folder in OU Campus.

After either of the above processes has been
completed:
1. Click Upload.
2. Enter a filename for the image in the Save As
modal. When Save is clicked, the image will be
uploaded onto the staging server. Publish the image
to the production server in order to see it in preview
mode.
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Image upload location
When you upload images to OU Campus, save them in the images folder within your
section folder. For example, if you are responsible for the Department of English website,
your images will be uploaded and saved to academic > english > images.

Editing images
You may use the OU Campus Image Editor to resize and crop your images. Some users,
however, prefer to use a separate photo-editing program such as Adobe Photoshop. (For
instructions on modifying and saving an image in Photoshop, see page 90.) If you do not
have access to Photoshop, contact Public Affairs and Marketing for additional program
recommendations.

OU Campus Image Editor
The Image Editor allows images to be resized, cropped, rotated and zoomed directly
within OU Campus. Images can be uploaded and edited all in one operation. The ability
to edit an image helps ensure large images are properly resized before being published to
the production server. Additionally, images can be saved and renamed.

83

The Image Editor can be accessed using the following methods:
• Clicking on a linked image name within the Pages list view
• Clicking Upload and Edit from the Upload window when uploading an image in the
Pages list view
• When inserting images into an editable region from the Insert/Edit Image file chooser
while in the WYSIWYG Editor
• When inserting images into a new Web Content Asset
Image file types support by the Image Editor is browser dependent. The following file
types commonly used for web pages can be edited and saved with the Image Editor with
the most commonly used browsers:
• JPG/JPEG
• PNG
• GIF
• BMP
Accessing the Image Editor
The Image Editor can be accessed in three main ways:
•

Click the hyperlinked image name in the Pages list view

•

When uploading an image, click Edit and Upload from the Upload modal
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•

When adding an image to an editable region, the source of a page, or in a miniWYSIWYG Editor and uploading from the Select Image file chooser.

Image Editor Tools
From the Edit Image screen inside the Image Editor, the following functionality is
available in the Tools menu:
• Resize
• Crop
• Rotate
• Zoom
• Undo
• Redo
As the image is edited, an estimated file size is shown underneath the image panel. This
size will change as the image is resized and cropped.
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Resize
The Resize tool includes the ability to specify a new width and height for the image. The
original ratio for the image dimensions can be kept intact by selecting the Preserve
Ratio checkbox.
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Crop
The Crop tool can be used to crop the image, either by selecting a predefined aspect ratio
or by determining a custom crop size. When Custom or any of the predefined ratios are
selected, a crop box will appear. You can then adjust the crop for the image by dragging
the crop handles located on the edges of the crop box. Clicking the Swap width &
height checkbox will swap the dimensions of the crop box width and height (e.g., a crop
box with dimensions of 150x300 pixels would swap to 300x150 pixels).
Refer to the Recommended size and resolutions section on page 81 to find crop sizes for
particular image types.
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Rotate
The Rotate tool rotates the image 90 degrees in a clockwise direction with each click.

Zoom
The Zoom tool can be used to manually enter a percentage of the original image size to be
displayed in the Edit Image panel for editing. The plus and minus magnifying glass
buttons may also be used to increase or decrease the viewing size. Zoom does not alter the
size of the image on the staging server; it is only to aid users in the Image Editor.
The Original button reverts the image to the original size.
The Zoom to Fit button resizes the image to fit into the panel for viewing.
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Undo/Redo
The Undo and Redo functionality is available after performing another editing function.
Undo reverts the last function performed (one level back). The Redo function reapplies the
last function removed by the Undo tool (one level forward).

Notes
REMINDER: All images must be published to the production environment before they
appear live on the website. If you upload an image to the staging environment but do not
publish it (or submit it for your approver to publish), it may not appear in your Preview screen
and will not appear on the website.
An edited image must be republished in order to appear correctly on the rendered
webpage. This may be initiated with a page publish by selecting the checkbox to publish
unpublished dependencies. Or it may be necessary to manually publish the image.
If the image does not appear correctly, refresh the browser and/or clear the browser cache
as the previous iteration of the image may have been saved by the browser. This action
can be found in various places in browsers' settings and for some browsers/platforms, this
can be accomplished by pressing CTRL+F5 (Chrome), CTRL+R (Firefox and IE), or
⌘+Option+E (Safari). Otherwise the edited image may not appear as expected.
When an image is edited through The Image Editor in OU Campus, it will be
recompressed once it is saved. When using lossy file formats such as JPG, this can cause a
visible degradation in image quality, especially when an image is edited multiple times in
OU Campus. As a best practice, crop or resize images to the exact size needed on the page
before importing them into OU Campus. Furthermore, using images saved in a lossless file
format (such as PNG) in the Image Editor will avoid losses of quality due to
recompression.
If working with an image that cannot be edited, log out of OU Campus, quit and relaunch
the browser. This will free up browser-allocated RAM and may resolve the issue.
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To modify & save an image in Photoshop
1. Open the image file in Photoshop.
2. Crop or resize the image to the appropriate size using the crop or Image Size (Image >
Image Size) functions.

3. Select Save for Web in the File dropdown menu.

90

4.

Confirm that the image size is correct and that the image size is 500KB or smaller

TIP: If the image is too large, select “Very High” (80%) or “High” (60%) quality

5.

Name your file and save it in the desired location.

6.

Upload the file to your Images folder in OU Campus, to an asset or as an inline image.
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Main Content Inline Images
The maximum width of the main content field in a standard page is 800 pixels. Therefore,
full-width images should be sized to 800 pixels wide and can have varying heights. (In-line
photos can also be smaller than 800 pixels wide, including thumbnail-sized images.) We
recommend sizing photographs before uploading them to OU Campus.
Use the following process to upload a full-width inline image:
1. Size the image to 800 pixels wide at a resolution of 72 pixels per inch.
•

Alternatively, you may upload the image to the Images folder first, resize it to the
appropriate dimensions using the OU Campus Image Editor, then find and place it in
your webpage using the finder in the Insert/Edit Image menu.

2. Place the cursor where you would like your image to appear, then click the Insert/Edit
Image button in your WYSIWYG toolbar:

3. Select the folder finder icon in the Insert/edit Image window.
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4. Select the folder to which you want to upload the image. In most instances, this will be the
Images folder within your office or department’s main folder.

5. Click Upload.

6. Click the Add button and navigate to the Image file on your computer or drag-and-drop it
into the Upload window field.

93

7. In the Insert/Edit Image window’s Dimensions fields, replace 800 with 100% and leave
the height field empty. Make sure “Constrain proportions” box is checked.

8. Click “OK”

Photo galleries
Photo galleries are Assets, and are created and modified in the Assets section of the
Content dropdown menu.

To learn how to create an Asset, see page 70.

Placing a gallery on your page
1. Go to the page you’d like to edit, then click the Edit button in the Page Actions
Toolbar. Select the editable region where you’d like to add your photo gallery.
2. Click the Insert Asset button in the WYSIWYG editor
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3. Type in the search bar to find the asset you’re looking for, then select the correct asset
from the dropdown menu.

4. Make sure the correct Asset is highlighted, then click Insert
Alternatively, expand File Navigation using the folder icon in the upper right corner of the
window.

Then, toggle from Pages view to Assets view, find and place your asset.
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Assets cannot be displayed in the editable region view. After you’ve inserted the Asset, it
will look like this:

To delete an Asset, simply click on the Asset text (as seen above) and delete it.

Changing gallery types
To switch between Photo Slider and Thumbnail Grid gallery types, you’ll need access to
the Properties portion of the Page Action Toolbar. If you do not have access to this
portion, ask someone from Public Affairs & Marketing to assist you.
Your page automatically defaults to the Thumbnail Grid gallery type. To change gallery
types, make sure you have the page checked out, then click the Properties tab.
Under the Page Options heading, there is a dropdown menu for LDP Gallery Type. Select
the gallery you’d like, then click Save.

NOTE: You cannot have both a photo slider and a thumbnail gallery on a single page.
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Banner image/sliders
Like photo galleries, the banner image at the top of your website is an asset. Any changes
to your banner image and page header must be made to the Asset. To learn how to create
or modify an asset, see the Asset section on page 66.
To change the banner image asset on your page:
1. Go to the page you’d like to edit, then click the Edit button in the Page Actions Toolbar.
Click the green “Select Banner Slideshow Gallery Asset” button to change the banner
image.

2. Because Assets can’t be displayed in the WYSIWYG, you’ll see something like this:

To delete the existing Asset, click the text and press your Delete key.
3. Click the Insert Asset button in the WYSIWYG editor

(continued on next page)
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4. Type in the search bar to find the asset you’re looking for, then select the correct asset
from the dropdown menu.

5. Make sure the correct Asset is highlighted, then click Insert.
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VIDEO
Uploading videos
OU Campus makes it easy to upload videos into the main content of your web page using
the YouTube Gadget or the WYSIWYG toolbar.

Using the YouTube Gadget
1. Enter an editable region to edit the page.
2. If the Gadgets sidebar is not visible, click the Show Gadgets icon to show the sidebar.

3. Expand the YouTube Gadget.
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4. If the video is a Hope College video, select the channel where it’s housed; if not, select
All YouTube Videos.

5. If possible, use the Uploads dropdown to further narrow your selection.

6. Type in keywords to filter results.
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7. Click on the video to open a preview.

8. Click Insert.
9. Make any necessary changes in the Insert/edit Video window, then click OK.

10. The video cannot be displayed in your editable region. Save and exit, then view the
video in Preview.
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Using the WYSIWYG toolbar
1. Find the video on YouTube.
2. Click the Share button.

3. Copy the URL in the Share tab — do not copy the code from the Embed tab.

4. Go back to the editable region of your OU Campus page. Put your cursor where
you’d like to insert the video, then click the Insert/edit Video button in the
WYSIWYG toolbar.
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5. Paste the URL into the Source line.

6. Click OK.
7. The video cannot be displayed in the page’s editable region. Save and exit, then view
the video in Preview.

Troubleshooting video dimensions
Did your video upload at all the wrong proportions? Are there black bars above and below
your video? We’re working on it.
In the meantime, here’s how you can fix it:
1. Click on the gray video box in the page’s editable region.

2. Click the Insert/edit video button in the WYSIWYG editor.
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3. YouTube’s standard dimensions are 480 x 270. Uncheck the Constrain proportions box,
then type 480 x 270 into the Dimensions field.

4. Save the changes.
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WORKFLOW
An editorial workflow describes the way people use a process to get things done. The workflow
you use will vary slightly depending on your department, the people on your team, and the
roles and tasks you’ve been given.
For more information about workflows at Hope College, refer to the Web Content Guidelines
document.
In OU Campus, Workflow is a component of the Mailbox that allows you to track content
that has been sent for review through the approval process. It shows content that you have
submitted to another user or, in some cases, have received from another user.
Additionally, content that has passed through or completed a workflow process (e.g., when
content was approved and published, or the request was declined or canceled) is also
shown in this view.

Workflow can be found in the global navigation bar at Dashboard > Workflow or by
clicking the Workflow link near the user's name on the Dashboard page.
For most users, the Submit button allows you to submit content directly to your approver
(usually Public Affairs and Marketing) before it is published. (Some users may have
independent publishing permissions.) You can include a message along with the
submission. These messages, along with a link to the content, appear in the approver's
Workflow list view.
General messages unrelated to approvals that are sent to your account will not be found
on the Approval page. They are available in the Inbox.

Workflow Screen
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The Workflow screen includes the following features and functionality:
• The number of items in the Workflow
• Filter tool to narrow down visible results in the list view
• Selection checkboxes to select and delete multiple messages at a time, or to view a
single workflow message
• Sortable columns in the list view. Messages can be sorted by From, Approver, File,
Status, or Date
• The linked file name which can be clicked to preview the content
• Status icons indicated where the page is in the workflow process
• The date and time that the content was sent for approval

File
The approver can click the linked file name to preview the content. Content that is sent to
an approver is automatically checked out to that user; he or she can perform various
actions on the content, including decline and revert. For example, if the content is an
image, clicking the link in Workflow will bring up the Image Editor. If the content is a
page, the preview of the page is shown.

Status
A status icon is shown in the Status column for each content item. Content listed in
Workflow can be previewed by any user, but it can only be checked out and modified by
the user to whom it was sent. Clicking a status icon shows the Workflow Message.
Status Icon

Description
Pending Approval (by another user)
Pending Approval (by the current user)
Approved and Published
Declined
Cancelled from Workflow

View
When content is sent for approval, the sender can attach a message. This is associated with
the item in Workflow as a Workflow Message, which can be viewed:
• Hovering over the file row and clicking on the View option
• Clicking the Status icon
• Selecting the checkbox next to the item and clicking View
From within the message, users can:
• Click the linked file to preview the content sent for approval
• View the workflow details, including the site from which the content originated, the
status, the date of the latest action indicated by status, who sent the content and the
approver. This also shows the message's details: the date and time the message was
sent, the subject, and the message (if any).
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•
•
•

Delete the message
Reply to the message
Navigate back to Workflow

Reply
You can reply to workflow
messages by clicking the Reply
button in the message. The Reply
dialog is shown. You can add
additional users or groups to the
message, change the subject, and
add a message. Optionally, a copy
of the message can be sent by
external email in addition to the
internal OU Campus message.
Clicking Send will send the
message to the designated users
and/or groups and will return the
user to the original Workflow
message. Clicking Cancel returns
the user to the original Workflow
message without sending a reply.

Delete
Workflow items can be deleted
with one of the following actions:
• Hovering over the file row and
clicking Delete
• Clicking Delete in the Workflow Message view
• Selecting the checkbox next to the item or multiple items and clicking Delete
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